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Introduction
Wavelink VelocityCE is a powerful server-side Web browser paired with an easy to use client-
side viewing application. The VelocityCE Server performs most of the browser functions and 
processes. The data is then relayed to the client in a functional lightweight format. Users 
receive all the benefits of a fast browser without the additional processing taking place on the 
client.

VelocityCE neatly organizes each session on a VelocityCE server using the WebKit browser 
engine, the basis for browsers such as Google Chrome and Apple Safari.

Engineered with the mobile worker in mind, VelocityCE makes using current Web 
applications easier and faster. Specifically built for use in ruggedized devices with scanners 
and for environments with intensive scanning applications and operations, companies are able 
to increase productivity without making drastic changes to current inventory and equipment. 
With over 15 years of engineering expertise specifically with ruggedized mobile devices, 
VelocityCE is successful even in the most challenging of environments where users must 
maintain application connectivity or where RF coverage is poor.

VelocityCE is fully compatible with Wavelink Avalanche, a mobile device and infrastructure 
management solution, and Wavelink Speakeasy, software that voice-enables your applications.

This guide provides information on installation, configuration, and developing and using web-
based applications for VelocityCE. 
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Installation and Licensing
The VelocityCE Client must be configured and installed on a mobile device before you can use 
it. It also needs to be licensed before you can use it with full functionality. 

The Client is configured to automatically re-install in the event of a cold boot. The cold boot 
recovery process ensures that both the VelocityCE Client application and configuration 
survive the cold boot. 

The generic VelocityCE Client will not survive a cold boot.

To allow the Client to survive a cold boot, a backup copy of the Client is stored in the non-
volatile Flash memory of the device. A copy of any configuration files for the Client are also 
stored in this location.

The following topics offer additional information:

• System Requirements

• Configuring and Deploying the Client

• Licensing the Client

• Installing and Configuring the VelocityCE Server

System Requirements
The VelocityCE Server must be installed on a computer meeting the following requirements:

• 64-bit OS (Windows Server 2008 R2 or Windows Server 2012 are recommended)

• 16 GB RAM

• Xeon CPU based on the Nehalem micro-architecture with at least 4 cores and hyper-
threading

The VelocityCE Client is supported on the following operating systems: PocketPC 2003, 
Windows Mobile 5.0, Windows 2000/XP, and Windows CE .NET 4.2/5.0.

Configuring and Deploying the Client
The VelocityCE Client is configured and installed using one of the following methods:

• Wavelink Avalanche. If your mobile device is running the Avalanche Enabler, you can use 
Avalanche to deploy the VelocityCE Client and Client configurations to a mobile device. 
For more information on configuring the client using Avalanche, see Using Avalanche to 
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Configure the Android Client.

• Microsoft ActiveSync. You can install the VelocityCE Client configuration utility on a host 
PC. The configuration utility uses an ActiveSync connection between the host PC and the 
mobile device to deploy the Client and configurations to the mobile device.

• Third-Party Applications. Wavelink supports some third-party deployment applications. 
For more information about supported deployments for your device, please see the 
Wavelink Web site. If you choose to use a third-party application to configure and install 
the VelocityCE Client, please see the documentation for that application for details on this 
process.

Depending on the VelocityCE Client installation and configuration utility that you are using, 
some tools that allow you to configure the app's features may not be available. Tools for 
configuration may include the following:

Host Profiles A host profile contains all of the required information for a mobile device to 
connect to a host system, including an alias, IP address, TCP port, and other 
connection-specific parameters. The VelocityCE Client supports multiple host 
profiles to allow a user at the device to easily create sessions with various 
hosts. For information on the options available for a host profile, see 
Configuring the Host Profile on page 11.

Configuration 
Settings

Configuration settings provide control over many aspects of a session, 
including key macros, text and screen display, and barcode scanning. You 
may control the settings on a global level or on a per-host level. For 
information on changing configuration settings, see Configuring VelocityCE 
Settings from the Configuration Manager on page 18.

Script Editor You can automate actions for the VelocityCE Client using scripting. For 
example, you might create a login script for users. You may record scripts, or 
you may use the Script Editor to create new scripts or modify existing scripts. 
VelocityCE uses the same scripting language as Wavelink Terminal Emulation. 
For information on creating scripts for the VelocityCE Client, see the Terminal 
Emulation Scripting Reference Guide.

Keyboard 
Creator

Use the Keyboard Creator to modify the standard VelocityCE Client virtual 
keyboards to meet the needs of your production environment. The Keyboard 
Creator allows you to completely modify the layout of the virtual keyboard. 
Additionally, import your own graphic files (bitmaps) to create your own 
unique buttons for the keyboard. For information on using the keyboard 
creator, see Keyboard Creator on page 23.
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Resource 
Editor

The Resource Editor allows you to deploy graphic and sound files to your 
mobile devices. You may add, modify and deploy any .bmp or .wav file 
using the Resource Editor. For information, see Resource Editor on page 29.

Import/Export 
Settings

If you have already configured a VelocityCE Client and you want to use that 
configuration for other Clients, you can import or export settings.

The following topics offer additional information:

• Using ActiveSync to Configure and Deploy the Client

Using ActiveSync to Configure and Deploy the Client

Use the Microsoft ActiveSync installation and configuration utility to configure host profiles, 
Client settings, and localization. After you have created the configuration, push the 
configuration files to the mobile device over a Microsoft ActiveSync connection.

To configure the VelocityCE Client using Microsoft ActiveSync:

1  Create an ActiveSync connection between the system you are using to install and the 
device you are deploying to. This can be a Guest or a Standard partnership.

2  Download and run the ActiveSync VelocityCE Client installation and configuration utility 
on the host system.

The Wavelink Product Configuration dialog box appears.

ActiveSync Installation and Configuration Utility

3  Click the icon buttons to open the VelocityCE Client configuration tools and configure the 
Client as desired.
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4  Use the buttons Application & Config, Application Only, and Config Only to deploy the 
Client and/or its configuration to the device.

Licensing the Client
The VelocityCE Client requires a license for full functionality. You can use the Client without a 
license, but you will be limited to the demo version without full functionality.

VelocityCE Client licensing is on a per-client basis, not on a per-connection basis. This means 
that a single license allows the VelocityCE Client to engage in the maximum number of 
sessions it is configured to support (up to four concurrent sessions).

When the VelocityCE Client does not have a valid license, it operates in demo mode. When 
operating in demo mode, it behaves as follows:

• When you attempt to initiate a VelocityCE session, the Client will begin broadcasting in an 
attempt to locate a license server. At that point, you are prompted to either enter a license 
or to initiate the session in demo mode. 

• While in demo mode, you may initiate multiple sessions with hosts. However, each 
VelocityCE session that you initiate will automatically disconnect after one hour.

The following topics offer additional information:

• Types of Licenses

• Licensing Methods

• Configuring the License Server Address

Types of Licenses

There are two types of VelocityCE Client licenses: platform licenses and maintenance licenses.

• Platform licenses. A platform (or base) license authorizes you to use a version of the 
VelocityCE Client and any builds associated with that version. For example, if you 
purchased a 1.0 VelocityCE Client license, then you are entitled to use 1.00-xx builds. If you 
want to upgrade beyond that version, then you must either buy a new platform license or 
purchase a maintenance license. Platform licenses do not expire, but they don't allow you 
to upgrade to a newer version of the Client.

• Maintenance licenses. A maintenance license allows you to upgrade your VelocityCE 
Client when new major versions become available. For example, a maintenance license 
allows you to upgrade from VelocityCE 1.x to VelocityCE 2.x.

Maintenance licenses are valid only through a specific date. After the expiration date, if 
you upgrade the VelocityCE Client, it will revert to operating in demo mode. 
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Licensing Methods

There are two ways to license the VelocityCE Client:

• Manual licensing. You may use the Client interface on the mobile device to manually 
input licensing information.

• License Server. You may use a Wavelink Terminal Emulation License Server to 
automatically provide Client licenses to the mobile devices on your network.

To obtain VelocityCE licenses, please contact Wavelink customer service. 

The following topics offer additional information:

• Manually Licensing the Client

• Using the License Server to License the Client

• Using Demo Mode

Manually Licensing the Client

You may key in your authorization information manually through the VelocityCE Client 
interface on the mobile device. 

To manually license a VelocityCE Client:

1  On the mobile device, launch the Client.

2  Add a license by tapping Options > Authorization or by attempting to establish a 
connection to a host. 

When you attempt to connect, the Authorizing Terminal dialog box appears. 

3  Tap Add License.

The Authorization dialog box appears.

4  In the Licensee Name text box, type the name of the person or company for which the 
Client is licensed.

5  In the Serial # text box, type the serial number for the license.

6  In the Exp. Date text box, type the expiration date of the license, in the format of 
MMDDYYYY.

7  In the Auth. Code text box, type the authorization code for the license.

8  In the User # text box, enter a user number.
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Each VelocityCE Client should have a unique user number. The user number can be any 
number between 1 and the maximum number of users for which the license provides.

9  In the Limit text box, enter the maximum number of users for the license. 

10  Tap Authorize.

The license type appears in the Platform text box.

Using the License Server to License the Client

The Terminal Emulation license server is a Wavelink application that is responsible for 
supplying licenses to mobile devices that are using the VelocityCE Client.

The TE license server should not be confused with the Avalanche license server. They are 
separate Wavelink applications.

For information about installing and configuring the client license server, see the TE License 
Server Reference Guide on the Wavelink Web site.

When you attempt to initiate a session with a host, if the VelocityCE Client is not already 
licensed, it will automatically attempt to obtain a license from a license server. 

To use the license server to obtain a license:

1  When you attempt to connect to a host using the Client, it broadcasts a request for a license 
on the local IP network. Or, if you have configured the license server address, the Client 
sends a request to the specified license server.

If the license server is not on the local network you must configure the license server IP 
address in order for the device to obtain a license. For more information, see Configuring the 
License Server Address on page 8.

The Authorizing Terminal dialog box displays on the mobile device while the VelocityCE 
Client attempts to locate a license server. License servers with an available license respond 
by offering a license.

2  The VelocityCE Client accepts the first license that it receives and sends a reply to the 
license server. The Authorizing Terminal dialog box on the mobile device indicates that a 
license has been obtained.

If no license server responds to the request for a license, then the Authorizing Terminal 
dialog box continues to display until you close the dialog box, run the Client in demo 
mode, or choose to manually add a license.
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Using Demo Mode

If you want to use the VelocityCE Client for demonstration purposes, you can run the Client 
in demo mode. The demonstration license automatically disconnects a session after one hour.

To use the VelocityCE Client demo license:

1  Launch the Client.

2  Connect to a host.

3  In the Authorizing Terminal dialog box, tap Start Demo.

The VelocityCE Client uses the demonstration license and attempts to connect to the host 
that you selected. Before displaying the host screen, the Client displays a screen that 
indicates that you are using a demonstration license.

Configuring the License Server Address

A mobile device will automatically find the license server on the local subnet. However, if your 
license server is located on another subnet, you will need to configure the mobile device with 
the IP address of the license server.

To configure the IP address of a remote license server:

1  Access the Configuration Manager. For instructions on how to access the Configuration 
Manager, see Configuring VelocityCE Settings from the Configuration Manager on page 18. 

2  In the Configuration Manager, locate the Licensing > License Server Addresses 
parameter.

3  Double-click the current property and then use the License Server Addresses dialog box to 
configure the IP address of the license server.

4  Click OK.

5  Save the new configuration.

6  Close the Configuration Manager and download the new configuration to the mobile 
device.

Installing and Configuring the VelocityCE Server
Wavelink recommends that the VelocityCE server be installed at a different location than the 
host server (that serves the web pages). Install the VelocityCE server in a location on your 
network where the devices can contact it and where it can connect to the desired hosts. 
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If you upgrade from a previous version of VelocityCE, the installer will implement all new 
features without resetting your current configuration.

To install the server:

1  Double-click the installation file to begin the installation.

2  A Welcome screen appears. Click Next.

3  The License Agreement screen appears. Click I Agree if you agree to the terms of the 
license.

4  The Choose Install Location screen appears. Click Browse to browse to the directory where 
you want to install, or click Install to use the default location.

5  The server is installed and begins running as a service. When the Completing the Setup 
screen appears, if desired, enable the Show Readme check box to view it and click Finish. 
The Readme file has information about server command line options and logging.

Generally speaking, the VelocityCE server default settings will provide the best working 
environment. However, you can configure encryption, client and session timeout settings, and 
logging settings through a file named velocity.cfg. This file can be accessed by clicking 
Start > All Programs > Wavelink VelocityCE Server > Configuration. 

Details on these settings and how to change them are included in the configuration file. To 
change settings for the server, open the configuration file and follow the instructions included 
in the file. Save your changes and restart the server (Wavelink VelocityCE Server in the list of 
Windows Services).

Wavelink recommends not changing the server logging settings unless directed by Customer 
Service. Changing the server logging setting to EVERYTHING may severely impact server 
performance. 
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Configuring the VelocityCE Client
In order to use the VelocityCE Client to access web-based applications, you must configure the 
client with the correct connection information and operating parameters.

The following topics offer additional information:

• Using SSL/TLS

• Configuring the Host Profile

• Configuring VelocityCE Settings from the Configuration Manager

• Client-Side Scripting

• Keyboard Creator

• Resource Editor

• Importing and Exporting Settings

Using SSL/TLS
The VelocityCE Client supports SSL- or TLS-encrypted sessions between the Client and 
VelocityCE Server. The Client also supports certificate validation for SSL/TLS connections. For 
specific instructions on how to install and configure the SSL/TLS utility, see Using SSL/TLS 
with Terminal Emulation on the Wavelink Web site.

To configure SSL or TLS, you need a self-extracting support utility and the Avalanche, 
ActiveSync, or AirBeam SSL/TLS package for the Client. The Avalanche packages are device-
specific; the ActiveSync and AirBeam packages are not device-specific.

When you enable SSL/TLS on the VelocityCE Server, it will only accept connections from 
Clients that are also using SSL/TLS. 

To enable and use SSL/TLS for the VelocityCE Client, perform the following steps:

1  Install the SSL/TLS Support Utility on the host system. The SSL/TLS support utility is a 
self-extracting executable that installs the required files that will allow you to configure 
SSL/TLS and certificates. You can obtain the SSL/TLS support package from the Wavelink 
Web site. This does not need to be installed at the same location as the VelocityCE Server.

2  Install the SSL/TLS Support Package on the Client. The VelocityCE Client will not be 
able to initiate SSL/TLS connections with hosts until you install the SSL/TLS support 
package on the mobile device. Use one of the following methods to deploy the SSL/TLS 
support package to the mobile device: the Avalanche Console, Microsoft ActiveSync, or a 
third-party application.
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3  Enable SSL/TLS on the Server. For information on enabling SSL/TLS for the server, see 
Installing and Configuring the VelocityCE Server on page 8.

4  Enable SSL/TLS in the host profile. This option is set on the VelocityCE Server tab of the 
Host Profiles dialog box. You can use existing certificates or create new certificates.

Configuring the Host Profile
Before you can use VelocityCE to view web pages, you must create a host profile. A host 
profile defines the parameters that the Client should use when it attempts to initiate a session 
with the host. 

To create a host profile:

1  Access the Edit Host Profiles dialog box.

2  Enter the host Name and Address in the appropriate text boxes and click OK.

The host profile is created. When you configure the host profile, tabs appear offering 
different options for Web settings. Configure the Host tab with a name for the host profile, 
the host address, and whether the Client is allowed to connect to the host directly or only 
through a VelocityCE Server.

Configuring the Host Profile
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The following topics offer additional information:

• VelocityCE Server Tab

• Access List Tab

• Insert Tab

• Proxy Tab

• Configuration Tab

• AutoLaunch Tab

VelocityCE Server Tab

The VelocityCE Server tab configures the device with the server version number, address, 
port, options for server and client disconnect, and encryption options. 

VelocityCE Server tab

The following list describes the options and configurable parameters in the VelocityCE Server 
tab.
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VelocityCE Server The version number of the VelocityCE server.

Address The address of the VelocityCE server.

Port The port the VelocityCE server is using.

Terminate 
VelocityCE 
Server Session

Indicates when the VelocityCE server should terminate the connection 
to the host.

Possible values:

• Never. The server never terminates the session established with the 
host. The Client is responsible for terminating the session. 

• On Network Error. The server terminates the session with the host 
when a network error occurs, such as a loss of network 
connectivity. 

• On Session Exit. The server terminates the session with the host 
when the session is terminated by the Client.

• Always. The server will terminate the session with the host on a 
network error or when the session is terminated. 

Client Reconnects 
if Unexpectedly 
Disconnected

If the Client is disconnected without receiving a message from the 
server that it was disconnecting, the Client will try to reconnect to the 
server.

Use SSL/TLS 
Encryption

Uses SSL or TLS to encrypt the information sent between the Client and 
the server. For more information on configuring SSL/TLS encryption, 
see Using SSL/TLS on page 10.

Verify Server 
Certificates

Uses server certificates to authenticate the server. Click Select 
Verification Certificates to create certificates or select existing 
certificates. 

Use Custom 
Encryption

The Client will use a custom encryption algorithm. The Client and 
server must be configured with the same passkey.

Access List Tab

Use the Access List tab to configure which web addresses can be accessed by the 
VelocityCE Client.
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Configuring the Access List Tab

The following list describes the options and configurable parameters in the Access List tab.

Allowed Web Server 
Addresses                         

Lists the web addresses that the VelocityCE Client is permitted to 
connect to.

Possible Values: Any valid IP address, host name, or web 
address

Allow web servers on the 
local network (subnet)                         

Indicates whether the VelocityCE Client can connect with any 
web server or only with servers on the local network.

Add Address Click this button to add a new IP or web address to the list of 
addresses that VelocityCE Client is permitted to connect to.

Delete Address After selecting an address in the list, click this button to delete 
the address.

Insert Tab

Use a host profile to add elements to HTML pages when you don't have access to the pages on 
the web host. Create the HTML in a text file, then select the position it should be inserted on 
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the page and the files to add it to. The following options are available when you insert a text 
file:

Description A description of the element to be inserted.

Position to 
insert the text 
into the web 
page

Where in the existing page the text should be inserted. Options include the 
beginning of the <head> element, the end of the <head> element, the 
beginning of the <body> element, or the end of the <body> element. 

URL Fragment Part of the target page's URL that must be matched in order for the text to 
be inserted.

Search Text Text on the target pages that must be matched in order for the text to be 
inserted.

To insert information to an existing page using a host profile:

1  Create a text file (.txt) with the HTML you want to insert.

2  Open the Host Profiles dialog box and select the host profile to apply your changes to.

3  Click the Insert tab.

4  Click Add Item.

5  Browse to the .txt file, select it and click Open.

The Web Page Data Insert dialog box appears. 
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Web Page Data Insert dialog box

6  Configure the options and click OK.

7  Save the configuration and deploy it to the device. 

Proxy Tab

Use the Proxy tab to configure proxy connections for VelocityCE. 
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Configuring the HTTP Proxy Tab

The following list describes the options and configurable parameters in the Proxy tab.

Connection Type Indicates the type of connection for the host profile to use.

Possible Values: <Direct Connection> <Use Explorer Default> 
<Use Proxy Server>

Default Value: <Direct Connection>

Proxy Server Indicates the location of the proxy server.

Possible Values: Any valid IP address, host name, or web 
address.

Port Indicates the network port for the proxy server.

Possible Values: Any valid port number.

Default Value: <8080>

Autologin Name Credential for logging in to the proxy server.
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Autologin Password Credential for logging in to the proxy server.

Do not use the proxy server 
when contacting local hosts

Indicates whether the VelocityCE Client should use the proxy 
server when contacting hosts that reside on the same network. 

Configuration Tab

Use the Configuration tab to modify configuration settings for the host profile. Settings that 
are configured from this tab will override the general device settings when the selected host 
profile is used.

Click Modify to access the Configuration Manager or Reset to restore default settings.

For more information about configuration settings, see Configuring VelocityCE Settings from 
the Configuration Manager on page 18.

AutoLaunch Tab

Use the AutoLaunch tab to associate a host profile with a session. When the user switches to 
the session, the Client automatically begins a session using the host profile settings. You can 
configure autolaunch for one host profile for each session. 

Each host profile is automatically launched only once each time the Client runs.

Configuring VelocityCE Settings from the Configuration Manager
Change how the Client interacts with the host using the Configuration Manager utility, which 
provides an organized list of parameters that you can modify. These may include display, 
logging, or scanner options. 

Use the product configuration utility or the VelocityCE Avalanche software package to access 
the Configuration Manager. Use the Configuration Manager to modify the settings and save it 
to a new configuration file. When you download the new configuration file to the mobile 
device, the existing configuration file is overwritten. To configure VelocityCE through an 
Avalanche software package, see Using Avalanche to Configure the Android Client.

Client settings can be applied globally for all host connections, or set on a per-host basis:

• Global Client Settings. Global Client settings apply to all of the host profiles with which 
you have configured a Client. Configuration Manager displays the name of the file that it is 
modifying in the title bar.

• Per-host Client Settings. Per-host Client settings apply only to a specific host profile. Any 
parameters changed on a per-host basis will override global parameters. You can access the 
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client settings for a specific host profile through the Host Profiles dialog box. 

Per-host settings are a subset of parameters. Not all Client settings are available for 
modification on a per-host basis.

The left pane of the Configuration Manager displays the Client settings that you can modify. 
The client settings are grouped by category. When you select a setting in the left pane, 
information about the setting displays in the right pane.

Client Settings

Access the Configuration Manager either through Avalanche or ActiveSync, depending on the 
method you use to install the Client. 

Using Avalanche to Configure the Android Client
VelocityCE can be configured through Avalanche for a more controlled and consistent user 
experience on Android devices.

For example, you can use an Avalanche payload to configure host profiles or client settings for  
Android devices with the VelocityCE application already installed. You can configure multiple 
host profile payloads for each device, but only one client settings payload.

You can configure VelocityCE using any of the following methods:

• Deliver touchless configuration payloads. If your Android devices are managed in 
Avalanche, you can use the VelocityCE Client Settings and VelocityCE Host Profile 
Configuration payloads to deliver changes directly to your devices for hands-free 
installation. For more information, see Configuring Client from Avalanche Licensed on 
page 20.

• Scan a QR code.  If your Android devices are not managed by Avalanche, you can create 
configuration payloads and print a QR code for devices to scan and install the changes. For 
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more information, see Configuring Client from Avalanche Unlicensed on page 21.

• Download a configuration file.  If your Android devices are managed by another mobile 
device management service like Avalanche, you can create configuration payloads in the 
Wavelink Configurator Console, download the configuration changes, and deploy the 
configuration file through an alternate service. For more information, see Configuring 
Client for an Alternate MDM on page 22.

Configuring Client from Avalanche Licensed

If you have your Android devices licensed through Wavelink Avalanche, you can use the 
VelocityCE Client Settings and VelocityCE Host Profile Configuration payloads to deliver 
hands-free app configuration to multiple devices at once. 

You can configure multiple host profile payloads for each device, but only one client settings 
payload. These payloads can only be deployed to devices managed in Avalanche.

To configure the VelocityCE Client when the device has an Avalanche license:

1  Log in to the Avalanche Console. 

2  Navigate to the folder where you want the payload created.

3  From the Profiles tab, click Add Payload in the Available Payloads panel.

4  The Payload dialog box appears. Select the iOS and Android option, and then the type of 
VelocityCE payload you want to create.

5  Configure the options as desired and click Save.

6  From the Profiles tab, click Add Profile in the Available Profiles panel.

7  The New Profile dialog box appears. Click Application Configuration.

8  Create a name for the profile, then select the payload or payloads you want to associate 
with the profile. Save your changes.

9  Select the checkbox next to the name of the profile and click Apply in the Available 
Profiles panel.

10  Deploy your changes. The next time the device checks in, the payload is automatically 
downloaded. When the VelocityCE Client is launched, the new settings are applied and the 
host profiles are available.

When the VelocityCE Client is launched, the new settings are applied and the host profiles are 
available.
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Configuring Client from Avalanche Unlicensed

Through Wavelink Avalanche, you can use the VelocityCE Client Settings and VelocityCE 
Host Profile Configuration payloads to create app configurations that Android devices locate, 
download, and install through a scanned QR code.

You can configure multiple host profile payloads for each Android device, but only one client 
settings payload. For devices not managed by Avalanche, you must print these configuration 
changes as QR codes for devices to scan.

To configure the Studio Client when the device does not have an Avalanche license:

1  Log in to the Avalanche Console. 

2  Navigate to the folder where you want the payload created.

In the Avalanche navigation tree, there is a Default device folder. If all of your devices are 
using the same configuration, you may want to use the Default folder. However, if you have 
devices using different configurations, create a separate folder for each configuration.

3  From the Profiles tab, click Add Payload in the Available Payloads panel.

4  The Payload dialog box appears. Select the iOS and Android option, and then the type of 
VelocityCE payload you want to create.

5  Configure the options as desired and click Save.

6  From the Profiles tab, click Add Profile in the Available Profiles panel.

7  The New Profile dialog box appears. Click Application Configuration.

8  Create a name for the profile, then select the payload or payloads you want to associate 
with the profile. Save your changes.

9  Select the checkbox next to the name of the profile and click Apply in the Available 
Profiles panel.

10  Deploy your changes.

11  In the Navigation Tree, click the View button to view the folder details.

12  On the Folder Details page, click Print QR Code.

13  The QR code for the payloads applied to the folder appears in the browser. Print or email 
the QR code as needed.

14  On the device, launch the VelocityCE Client. 

15  If the VelocityCE Client prompts you to scan the QR code, click OK and scan the QR code. 
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Otherwise, press the Menu button. When the main menu appears, tap Server 
Configuration > Scan Server Address and then scan the QR code.

The device connects to the Avalanche server and pulls the configuration information 
associated with the folder. The device is not enrolled in Avalanche and does not appear in 
the Avalanche inventory.

Configuring Client for an Alternate MDM

If you manage your Android devices through a mobile device management service other than 
Wavelink Avalanche, you can configure your VelocityCE Client settings through the Wavelink 
Configurator and download the configurations as a file for mass distribution. Using this tool, 
you can create the configuration in the Configurator Console, export it, and then use your 
mobile device management service to send the file to managed devices. 

You can configure multiple host profile payloads for each device, but only one client settings 
payload to a configuration file.

To configure the VelocityCE Client when the device does not have an Avalanche license and is managed 
by another service:

1  Go to https://configurator.wavelink.com.

2  Log in to the Wavelink Configurator Console. 

3  Navigate to the folder where you want the payload created.

4  From the Profiles tab, click Add Payload in the Available Payloads panel.

5  The Payload dialog box appears. Select the iOS and Android option, and then the type of 
VelocityCE configuration payload you want to create.

6  Configure the options as desired and click Save.

7  From the Profiles tab, click Add Profile in the Available Profiles panel.

8  The Smart Device Profile dialog box appears. Click Application Configuration.

9  Create a name for the profile, then select the Studio payload or payloads you want to 
associate with the profile. Save your changes.

10  Select the profile you created and click Apply in the Available Profiles panel.

11  Click the profile name.

12  On the Application Configuration Profile page, click Export Config.

Your browser downloads the Configuration.json file. This file can be renamed as 
needed.
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Client-Side Scripting
The Script Editor provides the ability to create and execute scripts that automate processes on 
the VelocityCE Client. The actions and settings you use to create VelocityCE scripts are located 
in a separate document called Wavelink Terminal Emulation Scripting Reference Guide. The 
document explains the usage of each action in detail and provides examples. The Scripting 
Reference Guide is located on the Wavelink web site.

The following steps outline the process of creating scripts using the Script Editor:

1  Launch the Script Editor. Launch the script editor from the Wavelink Avalanche Console 
or the ActiveSync configuration utility. 

2  Create a script using the Script Editor. Use the Script Editor to manually create the script 
code.

3  Configure an execution method for your script. Select from the available options the way 
you want to execute your script. 

4  Deploy the script to the Client. Use Avalanche or ActiveSync to deploy the script to the 
Client.

5  During an emulation session, execute your script from the Client. Using the activation 
method you selected for the script, activate and execute your script.

VelocityCE allows one active script per session. While one script is running, other scripts are 
not allowed to run. Scripts should be designed to perform their function and then 
immediately exit so that next script can run.

Scripts can only be run while a session is connected to a host. When a connection is dropped, 
the script is terminated. If you switch between sessions, the script running in the first session 
will be suspended until that session is active again.

Keyboard Creator
The keyboard creator allows you to modify or create custom virtual keyboards to use during a 
session. You can also import graphics files (bitmaps) to create unique buttons for the keyboard. 
The following table  shows the name of the default keyboard files.

File Name Keyboard Type

EMWEB.KB Displayed when a session is connected

EMNONE.KB Displayed when a session is not connected

EMNUM.KB Displayed for numeric keyboard
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To launch the keyboard creator from Avalanche:

1  From the Wavelink Avalanche Console, navigate to the Profiles tab, and select the profile 
that contains the VelocityCE client package.

2  In the Software Packages area, select the VelocityCE Client software package and click 
Configure.

The Configure Software Package dialog box appears.

3  Select Keyboard Creator and click OK.

The Keyboard Creator opens.

To launch the keyboard creator from the ActiveSync configuration utility: 

1  On the host system, launch the ActiveSync utility.

The Wavelink Product Configuration dialog box appears.

2  Click the Keyboard Creator button.

The Keyboard Creator appears.

Once you have completed the keyboard and keys, save your changes and deploy the changes 
to the device.

The following topics offer additional information:

• Creating Keyboards

• Creating and Configuring Keys

• Importing Keyboard Graphics

Creating Keyboards

There are two default keyboards: the default alpha keyboard and the default numeric 
keyboard. The default alpha keyboard is displayed by default. Multiple keyboards can be 
included in each keyboard file. The keyboards are linked together by shift keys (special keys 
which display another keyboard).

When you delete a keyboard that has keys associated with it, an option will be presented for 
dealing with any connections to the keyboard. Keys that reference the keyboard can be 
deleted, set to an empty value or redirected to another keyboard.

To add a keyboard: 

1  Launch the Keyboard Creator.

2  Select Keyboard > New Keyboard from the menu. 
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3  Enter a new name for the keyboard. 

Creating a New Keyboard

Keyboard names must start with a letter, may only contain numbers or letters, and can only be 
11 characters long.

4  Use the Key configuration options to configure each key of the keyboard. To resize a 
keyboard, mouse over the top border, right-side border, or the upper-right corner of the 
keyboard. When the double-sided arrows appear, click and drag the keyboard to the 
desired size.

To delete a keyboard:

1  Select Keyboard > Delete Keyboard from the menu. 

2  Select what action to take for the keys used by the keyboard.

Deleting a Keyboard

Creating and Configuring Keys

There are three types of keys that can be on a keyboard: 

• Normal keys represent letters, numbers, or other characters in the emulation and can also 
represent special emulation specific function keys. 

• Shift keys can point to any other keyboard in the current keyboard file. 
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• Hide keys hide the keyboard and allow an unobstructed view of the emulation screen.

The following topics offer additional information:

• Adding or Deleting a Key

• Sizing and Positioning Keys and Rows

Adding or Deleting a Key

You can add new keys to a keyboard and configure the key values and configure the following 
options:

• Label. Enter the text that will appear on the virtual key when it is displayed. 

• Reverse. Enable this option for a key that indicates the active keyboard type. 

• Key Value. Select from Key, Normal, Keyboard (shift), or Hide. Key values allow you to 
select emulation-specific actions to be assigned to the keys. The list of keys available will 
vary depending on the emulation type selected. 

Normal key values can be displayed or entered as a character value (the actual character 
created by the keystroke is shown), a decimal value (for characters which cannot be shown), 
or a hexadecimal value (for scan codes of special function keys).

To add a new key:

1  Select Keyboard > Add Key.

The new key will appear in the top left corner of the keyboard, or directly to the right of a 
selected key (if it will fit). 

2  Modify the values for the key using the key configuration options. 
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Configuring a New Key

3  Repeat to create additional keys for the keyboard.

To delete a key:

1  Select the key you want to delete.

2  Select Keyboard > Remove Key.

Sizing and Positioning Keys and Rows

You can use the configuration options in the Key region of the Keyboard Creator to modify 
the size and position of the keys on the keyboard.

The Fine Adjustments drop-down menu allows you to select what object you want to modify:

• Key Position. Select this option to move a selected key on the keyboard. You can also 
adjust the key position by clicking on the key and dragging it to the desired position.

• Row Position. Select this option to move an entire row.

• Keyboard Position. Select this option to move all the keys on the keyboard. 

• Key Size. Select this option to adjust the size of the key.

Once you select the object you want to modify, you can use the arrow buttons to move or 
size the keys and rows. The Adjust Distance slider determines how much of an effect each 
click of an arrow button will have. This is set on a scale of 1-10 pixels.

To position a key:

1  Select an existing key or click New Key. 

2  From the Fine Adjustments drop-down menu, select Key Position.
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3  Use one of the following methods to move the key:

• Use the arrow buttons to position the key in the desired location.

• Drag and drop the key to the desired location. 

To position a row:

1  Click a key in the row you want to position.

2  From the Fine Adjustments drop-down menu, select Row Position.

3  Use the arrow buttons to position the row in the desired location.

To resize a key:

1  Select an existing key or click New Key. 

2  From the Fine Adjustments drop-down menu, select Key Size.

3  Use the arrows to adjust the size.

Importing Keyboard Graphics

The default keyboard draws the keys on the computer screen. However, you can import a 
graphic to be displayed instead of the created keys. An imported graphic will be embedded in 
the .KB and .KBB files, so you will not need to save the imported graphic file on the device 
separately.

When you import a graphic to use as a key or set of keys, you will still need to create and 
position key values. Use the slider bar to change how dark the graphic and keys are while 
editing so that you can size and position the keys correctly. 

Be sure to label the buttons you create. If the mobile device is unable to display the bitmap 
image, the labels will still appear.

To import a graphic:

1  In the Keyboard Creator, click Import.

2  Navigate to the location of the bitmap image you want to import.

3  Click Open.

4  Click the Size Keyboard to Graphic button to make the keyboard the same size as the 
imported graphic. 

5  Use the slider bar to adjust the how dark and how light the graphics and buttons appear 
when editing.
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Resource Editor
The Resource Editor allows you to import sound and picture (.wav and .bmp format) files 
that can be deployed to your mobile devices. Launch the Resource Editor, add the bitmap and 
sound files, then update the device. 

To launch from the ActiveSync configuration utility: 

1  On the host system, launch the ActiveSync utility.

The Wavelink Product Configuration dialog box appears.

2  Click the Resource Editor button.

The Resource Editor appears.

To launch from Avalanche:

1  From the Wavelink Avalanche Console, navigate to the Profiles tab, and select the profile 
that contains the VelocityCE Client package.

2  In the Software Packages area, select the TE Client software package and click Configure.

The Configure Software Package dialog box appears.

3  From the menu list, select Resource Editor and click OK.

The Resource Editor opens.
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Launching the Resource Editor

The following topics offer additional information:

• Adding a Bitmap

• Adding a Sound

• Editing Files

Adding a Bitmap

Any graphic file with a .bmp extension can be added to the Resource Editor.

To add a bitmap:

1  From the right pane of the Resource Editor, click Add new bitmap.

The Open dialog box appears.

2  Navigate to the desired file and click Open.

The file appears beneath the Bitmaps folder in the left pane of the Resource Editor. 

Adding a Sound

Any sound file with a .wav extension can be added to the Resource Editor.
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To add a sound:

1  From the right pane of the Resource Editor, click Add new sound.

The Open dialog box appears.

2  Navigate to the desired file and click Open.

The file appears beneath the Sounds folder in the left pane of the Resource Editor. Play the 
sound by selecting it and clicking Play in the right pane of the editor.

Editing Files

You can use the Resource Editor to rename or remove files.

To rename files:

1  In the left pane of the Resource Editor, expand the appropriate folder and select the 
desired file.

2  In the right pane of the Resource Editor, click Rename.

The Rename Resource dialog box appears.

3  Enter the new file name in the available text box.

4  Click OK.

The new file name appears in the left pane of the Resource Editor.

To remove files:

1  In the left pane of the Resource Editor, expand the appropriate folder and select the 
desired file.

2  In the right pane of the Resource Editor, click Remove.

The Resource Editor dialog box appears.

3  Click Yes.

The file is removed from the Resource Editor.

Importing and Exporting Settings
You can import and export settings for VelocityCE Clients. This may be useful if you plan to 
install from more than one computer or if you have different models of devices that require 
the same configuration. When you export, you can export all settings or choose which items to 
export. 
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To export settings:

1  If you are using ActiveSync to install, open the Product Configuration dialog box and click 
Import/Export Settings.

-Or-

If you are using Wavelink Avalanche to install, configure the software package, select 
Import/Export Settings from the list and click Launch.

The Import/Export dialog box appears.

2  Select Export (save) all the current settings to a file to export all the settings and click 
OK. Or, to save only specific settings, select Export (save) selected settings to a file. If you 
choose to export selected settings, the Select Export Settings dialog box will appear, allowing 
you to choose the settings you want to export. Choose the desired options and click OK. 

The Save As dialog box appears. 

3  Navigate to the location you want to save the export file, provide a name for the file, and 
click Save.

4  The Success dialog box appears, informing you that the export file saved successfully. Move 
the file to the desired location so it can be imported for other devices.

To import settings: 

1  If you are using ActiveSync to install, open the Product Configuration dialog box and click 
Import/Export Settings.

-Or-

If you are using Avalanche to install, configure the software package, select Import/Export 
Settings from the list, and click Launch.

The Import/Export dialog box appears.

2  Select Import (load) settings saved in a file and click OK. 

3  The Open dialog box appears. Navigate to the location where the export file is, select it, and 
click Open.

The Success dialog box appears, informing you that the file imported successfully.

Whitelisting Allowed URLs
Through the use of an white list, the VelocityCE server gives administrators the ability to 
control the accessibility of web addresses for devices using the browser. By creating a while 
list, you are establishing a series of addresses users can access and use to perform their daily 
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duties. Each time a user accesses an address from their device, it automatically validates with 
the server against the list of provided white list addresses. Any addresses not included on the 
list become blocked from use.

The white list validates addresses in multiple formats for a wide range of access points. 
Acceptable formats include:

• Explicit DNS Entry: www.wavelink.com

• Wildcard DNS Entry: *.wavelink.com

• IP and Port: 192.168.1.50:81

• IP: 192.168.1.50

• IPv6 Address: FE80::213:1AFF:FE2F:380

• Explicit URL: www.wavelink.com/servlet/app

When entering addresses, consider following rules:

• Addresses with a greater range will always override more specific addresses. For example, 
if www.wavelink.com and www.wavelink.com/servlet/app are included on the 
same white list, www.wavelink.com will be the primary reference and allows access to all 
sub-pages at that domain.

• Do not include HTTP or HTTPS at the start of any address as this may result in failed 
connections.

• Port numbers are not required at the end of IP addresses.

To activate your white list:

1  Open the Velocity.cfg file. Locate the following text:

# URL whitelist file contains the addresses enforced by Velocity server.
# Velocity clients attempting to access an address not in the whitelist
# will be denied.
#
# White List File should be filled out with URLs that would be accessed.
#
# Return [/n OR /r/n] are used as separator between any addresses in white
# list file. Various formats of address can be accepted
#
# Explicit DNS entry:            www.wavelink.com
# Wildcard DNS entry:    *.wavelink.com
# IP and port:    192.168.1.50:81
# IPv6 address:    FE80::213:1AFF:FE2F:380
# Explicit URL:    www.wavelink.com/servlet/app

#WhiteListFile = WL.cfg
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2  To activate the white list, remove the # character at the start of the last line.

3  Save the file and close it.

4  Open the WL.cfg file.

5  Enter all allowed addresses.

6  Save the file and close it.

To deactivate an address from the white list, include a # at the beginning of the line.

A server restart is required to activate any white list changes. After restarting the server, when 
you attempt accesses an address not on the white list, a system alert appears and prevents 
access.
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Using the Velocity Client
This section provides information about using the VelocityCE Client.

The following topics offer additional information:

• Basic Navigation

• Using the Virtual Keyboard

Basic Navigation
The VelocityCE Client interface provides basic commands for navigating web pages.

To navigate within the VelocityCE Client:

1  Connect to a host.

2  Tap and hold on the screen.

A menu appears.

3  From this menu, you can select from the following options:

Back                         Go back one page.

Forward                        Go forward one page.

Stop Stops the current web page from loading.

Refresh Reloads the current web page.

Home Returns the browser to the specified home page. The home page is the first page 
users will see when connecting to the VelocityCE Client. The home page will be the 
location you set up in the host profile. For more information, see Configuring the 
Host Profile on page 11.

Text 
Size

Displays a menu with the following text size options: Largest, Larger, Medium, 
Smaller, Smallest.

Using the Virtual Keyboard
The VelocityCE Client contains a default keyboard. You can access the keyboard through 
Options > View. The different modes of the Web keyboard include alpha, numeric, function, 
punctuation, and config. The options for the config keyboard are listed below.
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Virtual Keyboard

The following list describes the function of the keys in the Web virtual keyboard.

Back                         Goes back one page.

Fwd Goes forward one page.

Stop                         Stops the web page from loading.

Refresh                         Reloads the current web page.

Home                         Returns the browser to the specified home page.

Prev Sess                         Cycles to the previous VelocityCE Client session.

Next Sess                         Cycles to the next VelocityCE Client session.

Close                         Disconnects the session. (Only available when the session is connected.)

Key Clicks                        Turns key clicks on/off

Quiet                         Turns quiet mode on/off.

Info Shows/hides the following information about the mobile device: VelocityCE 
Client version information, MAC address, IP address, ESSID.

Diags Opens or closes the VelocityCE Client diagnostic tools.

Alpha Displays the alpha keys, including a-z, Shift, Ctl, Alt, Esc, Tab, Caps, Enter, 
Space.

Num Displays the numeric keys, including 0-9, Shift, Esc, Tab, Ins, Enter, Space.

Func Displays the function keys, including F1-F24.

Punc Displays the punctuation keys, including: punctuation keys, Enter, Space.

Cfg Displays the configuration keys.

Off Hides the virtual keyboard.

Arrow Keys Moves the web page up and down or from side to side.
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Modifying Web Pages for VelocityCE
This section provides information about the custom META tags, IDA commands, and element-
specific actions supported by VelocityCE. If desired, use these to customize web pages to 
enable specific functionality in the VelocityCE Client.

The following topics offer additional information:

• META Tags

• IDA Commands

• Element-Specific Actions

META Tags
META tags are included at the top of a web page inside the <head> tags. They are evaluated in 
the order they appear in the web page (from top to bottom). The VelocityCE Client ignores 
tags it does not recognize. If a META tag starts with the iBrowse_ prefix, that prefix will be 
ignored. For example, iBrowse_ScannerNavigate is treated the same as 
ScannerNavigate.

Each META tag has the following format:

<meta http-equiv="[action_name]" content="[action_type]">

The action_type can be a URL, an IDA action, a JavaScript function, or a Wavelink script. 
For example:

<meta http-equiv="OnStartup" content="wls:WebAuto">

Some actions allow the action type to include replacement values; for example, a ‘%s’ or 
‘%d’ or ‘%ld’ string can be used to indicate where each replacement item belongs. These 
strings are interchangeable and can be used in any format that you prefer.

The following topics offer additional information:

• OnAllKeys, OnKey, OnKey0x

• OnStartup, OnLoaded, PowerOn

• Navigate Tags

• Printer Tags

• Scanner Tags

• Speakeasy Tags
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OnAllKeys, OnKey, OnKey0x

The OnKey and OnKey0x META tags describe an action that will occur if a particular key is 
pressed. The key values that are evaluated are the same key values used by Keyboard Creator. 
The OnKey0x format requires a hexadecimal number and the OnKey format requires a 
decimal format. The key value is case sensitive.

For example: 

OnKey50 and OnKey0x32 respond when the user presses 2. 

OnKey65 and OnKey97 respond to both the upper and lowercase A.

The OnAllKeys tag will perform the specified action each time any key is pressed. The 
action type can include one argument, which is the string representing the decimal value of 
the key.

OnStartup, OnLoaded, PowerOn

The OnStartup or OnLoaded META tags allow you to specify actions that will be taken 
when the web page is first loaded. OnLoaded  will not be called until the page has completely 
loaded.  There are situations where OnStartup will be called before the page is completely 
loaded, so images, stylesheets or JavaScript files may not be available.  So, for example, if 
OnStartup is calling a JavaScript function referenced by the web page, the call may fail.  In 
that case, use OnLoaded to make sure that the .js file functions are available.

The PowerOn META tag specifies an action for when the device changes from a suspended 
state to an active state.

Navigate Tags

The Navigate META tags are used to perform a task when the Client detects specific actions, 
such as signal strength changes, battery status changes, or scanned data. Use JavaScript or 
other functions to process the arguments that the Navigate tags use.

SignalNavigate

The SignalNavigate META tag is used to handle changes in the signal strength of the 
wireless network connection. The action occurs when the signal strength changes or when the 
device disconnects from the wireless network.

The three arguments (from left to right) are: signal strength, ESSID, and device MAC address. 
The signal strength ranges from 0-100. A signal strength result of -1 means "unknown." A 
signal strength of -2 means "disconnected from the wireless network." ESSID and MAC 
addresses may be "<unknown>". 

For example:



Modifying Web Pages for VelocityCE 39

<meta http-equiv="SignalNavigate" content="Javascript:onSignalStrength
('%s', '%s', '%s');">

ScannerNavigate and ScannerProcessed

The ScannerNavigate META tag is used to handle raw scan data. The 
ScannerProcessed tag  uses the scan data after it has been modified by the VelocityCE or 
other scan handlers. (VelocityCE scan handlers are set in the Client configuration settings.) 
The action occurs when information is scanned in. 

If the action has zero to three arguments, then the arguments are (from left to right): the 
barcode data, the symbology type, and the time stamp.

If the action has four or five arguments, then the arguments are (from left to right): the 
barcode data, source scanner name, symbology type, time stamp, and barcode length.

You can also use the Web Default Scanner Auto Keys configuration setting to configure the 
default scanner action on web pages without using META tags. For more information on 
configuration settings, see Configuring VelocityCE Settings from the Configuration Manager 
on page 18. 

BatteryNavigate

The BatteryNavigate META tag is used to handle changes in the battery strength or the 
AC line status. The action occurs when the battery strength changes or when the device is 
plugged in or unplugged.

The four arguments (from left to right) are: the AC line status, the strength of the main battery 
from 0-100, the strength of the backup battery from 0-100, and the main battery chemistry. A 
battery strength of 255 means "unknown".

For example:

<meta http-equiv="BatteryNavigate" content="Javascript:onBattery('%s', 
'%s', '%s', '%s');">

The following are the AC line status values:

Offline 00

Online 01

Backup Power 02

Unknown 255

The following are the battery chemistry values:
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Alkaline 01

Nickel-cadmium 02

Nickel-metal hydride 03

Lithium-ion 04

Lithium-ion polymer 05

Zinc-air 06

Unknown 255

Printer Tags

Use Printer tags to specify the printer that should be used for printing or send data to the 
printer by including the data in Printer META tags.

Printer Setup

Printer setup tags specify the printer to use for printing. Use one of the following Print_Setup 
tags:

Print_Setup_
TP

Selects the IP address and port of the printer for TCP printing. The format is  
address:port.

Print_Setup_
SP

Selects the serial printer using the number in the content value. 

Print_Setup_
IP

Selects the IRDA printer using the number in the content value.

Print_Setup_
BP

Selects the Bluetooth printer using the number in the content value.

Print_Setup_
NP

Selects the integrated printer for devices that include one. The content value is 
not used.

Use the following content values to select the printer type for Serial, Bluetooth, or IRDA 
printers:

0 PS1000

1 PS1001
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2 PS1004

3 LINEPRT  (Generic 9600 bps serial)

4 PDDUMB   (Used for Data South)

5 COMTEC   (5022)

6 MONARCH  (Monarch PathFinder)

7 RASCAL   (Monarch 9450)

8 RENEGADE (Monarch 9490)

9 COMTECPS

10 CODECOUR

11 COMTEC RF

12 COMTEC RF 9600

50 User Defined Printer

For example:

<meta http-equiv="Print_Setup_TP" content="192.168.1.59:7429">

Printing Data

Use the Print_Continue and Print_Finish action names to specify print data. The 
print data is in the action type of these META tags. The print data in the tag should all be on 
the same line in the HTML code and should not be more than 1024 characters in length. If you 
want additional characters, use a new Printer tag. In addition to standard characters, you can 
use the following:

• \r to specify a return character

• \n to specify a newline character

• \t to specify a tab character

• \\ to specify a backslash character

• \## or \x## to specify any other character, where ## is replaced with a two-digit 
hexadecimal number

Print_Continue should be used for all but the last section of print data, and Print_
Finish should be used for the last section of print data. The following tags are alternatives to 
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 Print_Finish: Print_Done, Print_Final, PLSeriesLabel_Print and 
ZebraLabel_Print.

The META tag Print_Callback can be used to check if the printing completed 
successfully. The argument will be 0 if the printing was successful, or a non-zero number if the 
printing failed. The following tags are alternatives to  Print_Callback:Print_Complete, 
ZebraLabel_Complete and PLSeriesLabel_Complete.

For example:

<meta http-equiv="Print_Continue" content="\22First Line\22\r\n">

<meta http-equiv="Print_Continue" content="\22Middle\22\r\n">

<meta http-equiv="Print_Finish" content="\22Last Line\22\r\n">

<meta http-equiv="Print_Callback" content="printresult.htm&status=%s"

Scanner Tags

This section includes tags that enable or disable the scanner or specific symbologies. 

If the action name is Scanner and the action type is Enable or Resume, the scanner will 
be enabled when the page is first loaded. If the action type is Disable or Suspend, the 
scanner will be disabled when the page is first loaded.

The additional scanner action types supported by the VelocityCE Client:

• AutoTab

• AutoEnter

• AutoEnterAndTab

• AutoTabAndEnter

• NoAuto

The AutoTab, AutoEnter, and AutoEnterAndTab action types will enable the scanner 
and will cause the scan data to be followed by an enter or tab key (or both). The NoAuto 
action type will enable the scanner and will clear the scanner key value (if a value is specified 
by the configuration settings).

When the scanner state is changed (using Enable, Resume, Disable or Suspend), the 
scanner will stay in that state until some other action (such as a META tag or IDA action) 
changes the state or until the user changes sessions.

Enable and disable different scanner symbologies by using the symbology as the action name, 
and Enabled or Disabled as the action type. The symbologies supported by the 
VelocityCE Client are:
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AUSTRALIA_POSTAL CUECODE PLANET

AZTEC D2OF1ATA PLESSY

AZTECMESA D2OF5 POSICODE

BOOKLAND DATAMATRIX POSTNET

BRITISH_POSTAL DUTCH_POSTAL QRCODE

CANADA_POSTAL EAN8 RSS14

CHINA_POSTAL EAN13 RSSEXPANDED

CODABAR I2OF5 RSSLIMITED

CODABLOCK JAPAN_POSTAL SIGNATURE

CODE11 KOREA_POSTAL TELEPEN

CODE16K MACROPDF TLC39

CODE32 MACROMICROPDF TRIOPTIC39

CODE39 MAXICODE UCC128

CODE49 MATRIX2OF5 UPCA

CODE93 MICROPDF UPCE

CODE128 MSI UPCE0

COMPOSITE OCR UPCE1

COUPONCODE PDF417 WEBCODE

In addition to the listed symbologies, the value ALL_DECODERS can be used to enable or 
disable all the symbologies.

For example, to enable only UPCA use the META tags in this order:

<meta http-equiv="ALL_DECODERS" content="Disabled">

<meta http-equiv="UPCA" content="Enabled">

The prefix Scanner_ can also be used with all symbologies.

For information on Scanner_Navigate or Scanner_Processed, see Navigate Tags on page 38. 
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Speakeasy Tags

Some META tags allow you to include Speakeasy functionality into a page. You must have the 
Speakeasy packages installed in order for the Client to use Speakeasy tags. If no Speakeasy 
package is installed, the VelocityCE Client will ignore Speakeasy tags. 

The SpeechFromText or TextToSpeech META tags play the string specified in the 
"content" attribute. For example:

<meta http-equiv="SpeechFromText" content="I will speak this sentence.">

The SpeechSetting META tag changes one or more values for Speakeasy. For example, 
the following META tag will change the Text-to-Speech settings for language and voice:

<meta http-equiv="SpeechSetting" content="tts_language=American English, tts_
voice=Tom">

IDA Commands
IDA commands are used to invoke a device action or program action by the VelocityCE Client. 
These values can be specified in many of the special META tags described above, as URLs for 
the user to click on, or called inside JavaScript functions.

For example:

<a href="ida:IDA_SESSION_DISCONNECT">Close the session</a>

-Or-

<script language=javascript>function OnError( ){     

Disconnect the Session     location.href = "ida:IDA_SESSION_DISCONNECT" ;

// Alternate Method     document.location = "ida:IDA_SESSION_DISCONNECT" ;

// Another Alternate Method     window.navigate ( "ida:IDA_SESSION_DISCONNECT" 
) ;

}</script>

It is recommended that each IDA command be preceded by the IDA prefix; however, the 
command will generally work without the prefix.

The following are IDA commands supported by the VelocityCE Client:

IDA_BEEP Causes the device to emit a standard beep (single tone).

IDA_ERROR_BEEP Causes the device to emit an error beep (two tones).
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IDA_COLDBOOT Causes the device to perform a cold boot.

IDA_COLDBOOT_PROMPT Gives the user the option to perform a cold boot or cancel 
the action.

IDA_KEYBOARD_WEB, 
IDA_KEYBOARD_SHOW, or 
IDA_KEYBOARD_UP

Cause the on-screen keyboard to be displayed.

IDA_KEYBOARD_NUM or 
IDA_KEYBOARD_NUMERIC

Cause the numeric on-screen keyboard to be displayed.

IDA_KEYBOARD_NONE, 
IDA_KEYBOARD_HIDE, or 
IDA_KEYBOARD_DOWN

Cause the standard and numeric on-screen keyboards to be 
hidden.

IDA_PROGRAM_EXIT Causes the device to exit the current program.

IDA_PROGRAM_EXIT_
PROMPT

Prompts the user to exit the program or cancel the action.

IDA_REPRINT Causes the last data supplied to the printer to be sent again. 
The print data will remain available until something else is 
printed or until the session is disconnected.

IDA_SESSION_S1
IDA_SESSION_S2
IDA_SESSION_S3
IDA_SESSION_S4

Cause the device to switch to the specified session.

IDA_SCAN_DISABLE or 
IDA_SCAN_SUSPEND

Disable the bar code scanner. When the bar code scanner is 
disabled, pressing the mobile device trigger will have no 
effect.

IDA_SCAN_ENABLE or
IDA_SCAN_RESUME

Enable the bar code scanner. The bar code scanner will not 
scan for bar codes unless the mobile device trigger is pulled. 
You can use the META tag OnStartup with an action of 
IDA_SCAN_ENABLE or IDA_SCAN_DISABLE to change the 
scanner state only when the page is first loaded.
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IDA_SCAN_FORWARD Disables the barcode scanner and processes a trigger press as 
a key press. This command only functions on scanners that 
support trigger-press forwarding; on all other scanners, the 
command performs the same action as IDA_SCAN_
DISABLE.

IDA_SESSION_
DISCONNECT

Disconnects the session and closes the VelocityCE Client.

IDA_SESSION_
DISCONNECT_PROMPT

Prompts the user to disconnect the session and close the 
VelocityCE Client, or cancel the action.

IDA_SESSION_NEXT Opens a new session.

IDA_SESSION_PREVIOUS or 
IDA_SESSION_PREV

Causes the device to return to the previous session.

IDA_SIP_SHOW or 
IDA_SIP_UP

Cause the SIP on-screen keyboard to become visible.

IDA_SIP_HIDE or 
IDA_SIP_DOWN

Cause the SIP on-screen keyboard to become hidden.

IDA_SIP_TOGGLE or 
IDA_SIP_TOGGLEHIDE

Toggle the SIP on-screen keyboard between visible and 
hidden.

IDA_SUSPEND or 
IDA_SUSPEND_DEVICE

Cause the device to suspend itself. For CE devices, this is 
similar to pressing the power button.

IDA_SUSPEND_PROMPT Prompts the user to suspend the device or cancel the action.

IDA_URL_BACK or 
IDA_BACK

Displays the screen previous to the current screen. If there 
are no previous screens, no action will be taken.

IDA_URL_BACK_DISABLE or 
IDA_BACK_DISABLE

Disable the Back menu option so it cannot be selected by the 
user. The IDA_URL_BACK or IDA_BACK commands are not 
affected and will still work.

IDA_URL_BACK_ENABLE or 
IDA_BACK_ENABLE

Enable the Back menu option so it can be selected by the 
user. The menu option could still be disabled if there is no 
page to go back to.



Modifying Web Pages for VelocityCE 47

IDA_URL_FORWARD or 
IDA_FORWARD

Displays the screen that was being displayed before the last 
Back command. If there is no such screen, no action will be 
taken.

IDA_URL_FORWARD_
DISABLE or 
IDA_FORWARD_DISABLE

Disable the Forward menu option so it cannot be selected by 
the user. The IDA_URL_FORWARD or IDA_FORWARD 
commands are not affected and will still work.

IDA_URL_FORWARD_
ENABLE or 
IDA_FORWARD_ENABLE

Enable the Forward menu option so it can be selected by the 
user. The menu option could still be disabled if there is no 
page to return to.

IDA_URL_HOME or 
IDA_HOME

Cause the VelocityCE Client to proceed to the location 
specified by the current host profile. This location is 
completely independent from any other web browsers on 
the device.

IDA_URL_HOME_DISABLE 
or IDA_HOME_DISABLE

Disable the Home menu option so it cannot be selected by 
the user. The IDA_URL_HOME or IDA_HOME commands 
are not affected and will still work.

IDA_URL_HOME_ENABLE or 
IDA_HOME_ENABLE

Enable the Home menu option so it can be selected by the 
user.

IDA_URL_REFRESH or 
IDA_REFRESH

Cause the web page to be reloaded. The server will be 
queried to verify that the page contents are up-to-date.

IDA_URL_STOP or 
IDA_STOP

Cause the web page to stop loading. If the web page is 
already fully loaded, this action has no effect.

IDA_WARMBOOT Causes the device to perform a warm boot.

IDA_WARMBOOT_PROMPT Prompts the user to perform a warm boot or cancel the 
action.

IDA_ZOOM_DISABLE or 
IDA_FONT_DISABLE or 
IDA_ZOOM_LEVEL_
DISABLE

Disable the Text Size menu so it cannot be selected by the 
user. The IDA options to set the zoom level (text size) are not 
affected and will still work.

IDA_ZOOM_ENABLE or 
IDA_FONT_ENABLE or 
IDA_ZOOM_LEVEL_ENABLE

Enable the Text Size menu so it can be selected by the user.
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IDA_ZOOM_LARGER or 
IDA_FONT_LARGER or 
IDA_ZOOM_3 or
IDA_ZOOM_LEVEL_3 or
IDA_ZOOM_LEVEL_LARGER

Displays the text using a large text size. This setting is global 
and affect other browsers on the device.

IDA_ZOOM_LARGEST or 
IDA_FONT_LARGEST or 
IDA_ZOOM_4 or
IDA_ZOOM_LEVEL_4 or
IDA_ZOOM_LEVEL_
LARGEST

Displays the text using the largest text size supported by the 
browser. This setting is global and affects other browsers on 
the device.

IDA_ZOOM_MEDIUM or 
IDA_FONT_MEDIUM or
IDA_ZOOM_2 or
IDA_ZOOM_LEVEL_2 or
IDA_ZOOM_LEVEL_
MEDIUM

Displays the text using a medium text size. This setting is 
global and affects other browsers on the device.

IDA_ZOOM_MINUS or 
IDA_FONT_MINUS or
IDA_ZOOM_LEVEL_MINUS

Displays the text using the next-smaller text size than the 
current text size. This setting is global and affects other 
browsers on the device.

IDA_ZOOM_PLUS or 
IDA_FONT_PLUS or 
IDA_ZOOM_LEVEL_PLUS

Displays the text using the next-larger text size than the 
current text size. This setting is global and affects other 
browsers on the device.

IDA_ZOOM_SMALLER or 
IDA_FONT_SMALLER or 
IDA_ZOOM_1 or
IDA_ZOOM_LEVEL_1 or
IDA_ZOOM_LEVEL_
SMALLER

Displays the text using a small text size. This setting is global 
and affects other browsers on the device.

IDA_ZOOM_SMALLEST or 
IDA_FONT_SMALLEST or
IDA_ZOOM_0 or
IDA_ZOOM_LEVEL_0 or
IDA_ZOOM_LEVEL_
SMALLEST

Displays the text using the smallest text size supported by 
the browser. This setting is global and affects other browsers 
on the device.
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Element-Specific Actions
The following custom attributes are supported for individual elements on a page:

• OnAllKeys, OnKey, OnKey0x

• Scanner

• Symbologies

The attributes can be specified in the tag that creates the element on the web page. If the 
element is selected (active), then the option will be applied. When the element is not selected 
(inactive), then the settings will be those specified by the META tags for the web page.

To use these as attributes for an element, use the format: action_name="action type"   

For example, the following tag will cause the scanner to be enabled when the input field is 
selected on the web page.

<input name="item1" id="item1" type="text" Scanner="Enable">

The following tag will enable the scanner only while the tag is selected. The scanner will 
otherwise be disabled.

<meta http-equiv="Scanner" content="Disable">

You can use the META tag OnStartup with an action of IDA_SCAN_ENABLE or IDA_
SCAN_DISABLE to change the scanner state only when the page is first loaded.

To use element-specific symbologies, you can either use the symbology name or prefix the 
symbology name with the string "Scanner_".

For example, the following tag will enable the scanner, AutoTab after an item is scanned, and 
turn off all symbologies except Code128. 

<textarea name="item2" Scanner=AutoTab Scanner_All_Decoders=Disable 
Scanner_Code128=Enable>

Attributes are processed left to right, so in this example, Code128=Enable must come after 
Scanner_All_Decoders=Disable.
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Wavelink Contact Information
For product downloads or documentation, go to the Wavelink downloads page:

http://www.wavelink.com/download-software

For information on contacting Wavelink, please go to:

http://www.wavelink.com/Customer-Care-Contact-Customer-Care

http://www.wavelink.com/download-software
http://www.wavelink.com/Customer-Care-Contact-Customer-Care
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